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SoftFares 2011 wp

SoftFares are also available in a version for Microsoft and 
Nokia's new smartphones coming to Scandinavia in 
September.

The app only works if you already use SoftFares SL.

The app can be downloaded from the phone's 
marketplace. Search for SoftFares. The price has still to 
be determined but we expect it to be around 200,00 DKK 
per phone.



Looking for a good mid-and back office for your Travel Agency?

Contact TravelOffice for a free demonstration!





SoftSuitCase software

To find the SoftSuitCase software, go to:

http://www.softsuitcase.com

Select DOWNLOAD at the top of the screen:

We are always adding new software to the list, but 
here are some examples:

SoftSuitCase.
Here you can find the latest and previous versions 
of the SoftSuitCase software.

Transfer from CRS
This software is used to transfer information from all 
four CRS's to SoftSuitCase.

SoftAmadeus
A simple Amadeus screen that can be used away 
from the office, etc., The software can be used 
simultaneously with Amadeus Vista (Selling 
Platform).

SoftFares
Sales tool and ticket robot. Contact the issuing 
agencies for further information.

In addition, there is a wide range of other software 
and utilities, briefly described below:

SQL Native Client
Communication program between SoftSuitCase and 
the database. It is included in the download of most 
of our software.

Crystal Reports Framework
Report tool. It is included in the download of most of 
our software.

.Net Framework
Framework for SoftSuitCase. It is included in the 
download of most of our software.

The database is usually installed, but if you need a 
new database, this can be downloaded from 
database section, select:

Database Setup for Soft SuitCase

In order to setup SoftSuitCase, it is necessary to 
have the database Setup program installed on at 
least one PC in Travel Agency. The program is also 
used for the overall maintenance of SoftSuitCase. 
Select:

Update Database Setup for Soft SuitCase
in order to install the application on your PC.

See further information in the manual , under 
Database Setup.

In order to correctly download and install the 
software on your PC, you should use Microsoft 
Internet Explorer as the WEB browser.
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Installation of SoftSuitCase
Install SoftSuitCase, as described on the previous 
page. If during the installation there are any 
questions or warnings, answer Yes. When the 
installation is complete, the following setup window 
will appear:

Amadeus Office ID is your Office ID in Amadeus.

The Database type is almost always Microsoft SQL

IP address is the IP address of the server where 
the SoftSuitCase Database is located.

Server is the name of the SQL database. 
(SQLEXPRESS)

Database Name is the name of the Database Setup 
database which by default is called 
(SuitCaseSetup).

Database Username is almost always: sa

Database password is your administrator's 
database password.

Reports Directory is the path to your reports

Press Check Connection. If the Setup is OK, it must 
be saved with the SAVE, and SoftSuitCase must be 
restarted.

If you had previously installed SoftSuitCase on your 
PC, you can retrieve the last saved settings in the 
Menu Item EDIT, and then GET GENERAL 
SETTINGS. This feature reinstalls the last saved 
Setup Settings.

Fill out the Setup data that will be used when 
installing a new PC at your Travel Agency.

Sabre / Worldspan / PCC / Amadeus Office ID:

Database type:
  

IP adresse:

Server:

Database name:

  

Database Username:

  

Database password:

Report directory:

Licenses
You can purchase as many licenses as you wish. 
You can always install SoftSuitCase on a new 
workstation, and it will work for 5 days after the 
installation. However it is important that if you have 
ordered and paid for new license, that you register 
that new license before the 5 days have elapsed or 
the software at that work station will stop working.

The licenses are registered by MAC Address, so you 
must have that at hand.
This is in the Login screen.

Transfer of a license from an existing registered PC 
to a new PC.
Install SoftSuitCase on the new PC as described 
here, and then contact TravelOffice. You must have 
the MAC address (it appears in the SoftSuitCase 
Login screen) of both the new and the old PC ready 
when you contact TravelOffice. We then will move 
your license to the new PC, and the old one will no 
longer be able to be used. There is a small fee for 
transfer of license.

7
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Microsoft SQL
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SoftSuitCase Setup
The Menu for General Setup and maintenance can 
be found under the Menu > Administration  > 
Maintenance.

The first to be set up is the accounts information.
Select Setup Finance Account

The following window will appear:

Create the necessary accounts. There must be at 
least one of each of the following types:

Sales
Expenses
Customer
Supplier
Finance

Sales are Sales Accounts, which are used to 
invoice a customer.

Expenses are the associated Purchase Accounts. 
Expenses Accounts are not used by all agencies, 
but it is nevertheless necessary, with at least one 
account of this type.

Customer accounts are created to collect what your 
customers owe you. You must at least enter the 
default Customer Account but you can also have 
additional customer accounts for your business 
customers.

Supplier accounts are the vendor accounts. Where 
what you owe is collected. You must at least enter 
the default Supplier Account but you can also have 
additional Supplier accounts to collect what you owe 
individual suppliers, for example BSP, Diners Travel 
Account, AirPlus etc..

Finance accounts are  the accounts you create to be 
your bank and cash accounts, where you will be 
receiving your customer's payments.

To Create new account
Fill in the relevant fields and press Save.

To Delete an account
Select the account by pressing the gray box to the 
left of the text, and then press DELETE.

You cannot delete an account that has been used, 
but it can be made inactive, so it will not be shown 
as an option when selecting accounts.

Under Default Customer and Supplier accounts, you 
must specify which Customer and Supplier account 
that will be the default account.

You must also decide how your invoices will be 
closed and exported. Only export Closed Invoices: 
Invoice is closed only upon payment or approval. 
Close exported or Sent Invoices: Invoice will be 
closed as soon as it is sent or printed. Close Invoice 
Issued at midnight: Invoice closes at midnight.

Default Customer Days of Credit: Specifies the 
default credit. For example, 7, specifies that the 
customer must pay before 7 days after invoicing. -45 
specifies that the customer must pay 45 days before 
departure.

It is also possible to have the system automatically 
round up to the nearest whole amount, etc.

If you use Sales Tax, check the box. A box to enter 
your VAT number is provided. You must also specify, 
what the percentages are for each Tax Code from 1-
5 and what accounts they will use. VAT code P is a 
European marginal Vat, which is used to charge VAT 
on the profit of the journey, if both departure and 
destination are located within the European Union.
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Installing the database
In the majority of cases, the database will be 
installed and set up by TravelOffice. However if you 
wish to do the installation yourself, first contact the 
TravelOffice Help Desk and get assistance with the 
setup.

After the database is installed, the system must be 
set up for your Travel Agency.

On the left side provides of the menu, select:
Database Settings and Credit Card

Database:
Enter the Travel Agent's name, address, telephone 
number, etc.

Enter your OfficeID, or IPCC  or ID for the CRS, 
that you use. By default, a maximum of 2 CRS is 
allowed. If you have more you must have a 
separate license.

For the IPCC from Sabre, you must enter the User, 
Password and Host.

Then press Save Settings.

Press Settings on the left side of the form.

Enter or modify the information, and press the Save 
Settings.

On the right, you can see whether the system is 
properly installed. The must be an OK next to all the 
menu items.

At the bottom of the screen you can:

1. Download all reports to the system.

2. Verify the local settings.

3. Upload logo (770x230) for use by all prints.

4. Upload logo left (60x120) for use by all prints.

5. Upload logo right (60x120) for use by all prints.

In menu select Credit Card located to the left of the 
screen. Here you can create and maintain the Credit 
Card that the Travel Agent uses Online. This only 
works if the you have purchased the license for this 
module.

Select the desired Credit Cards, as well as 
information on 3D Secure and Foreign Cards.

Default is the Credit Cards, which all Travel Agents 
may use  without special permission.
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Setting up theEmployees or Users.
Each employee or user  must be set up in 
SoftSuitCase. It takes place in Maintenance, 
followed by User Setup.

The following screen appears:

Click the gray box next to each employee or user, if 
you want to edit a change.

To create a new user, enter the user's initials in the 
User ID box, and then press ENTER. Fill in the 
necessary fields.

A user cannot be deleted, but can be made 
inactive.

Description of individual fields

User ID
User login. Max. 3 characters

User name
User'ss full name

Password
Users's password

Security
The user's Level:
0: Supervisor
1: Bookkeeper/Department Manager
2: Super User
3: User (0)
4: User (1)
5. Student or similar.
6: Limited Read only!

See product sheet on User levels.

Department:
If you are working with multiple departments, it is 
here, where you can choose between the 
departments. See further along, how to create 
departments.

Position:
The employee's position within the company

Email:
Employee's Email

Tel. EXT:
Employee's extension

Tel. Direct
The employee's direct phone number

Default language
The language the employee wishes to use as the 
default display language.
In the current version supported:
1. English (UK)
2. English (US)
3. Spanish
4. Danish
5. Swedish
6. Norwegian (Under development)

Active:
If there is X in this field, the employee cannot log into 
SoftSuitCase.

Creating Departments.
You can set up branch offices in:
Administration > Maintenance > Department Setup

The following screen appears:

Add the Departments and then press Save.
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Before creating the Invoice Line Products you must 
have created the suppliers of those products.

In the menu, Administration, Maintenance, and then 
Suppliers.

Explanation for each field:

Name, address, country, etc.
Fill in the name and address of the supplier

IATA:
3 letter IATA code

Ccode:
Telephone Country Code.

Acode:
Telephone Area or City Code.

Email:
One or more Email addresses. Press + to add an 
Email address and a Contact name.

Remarks
Remarks about the supplier

Supplier Group:
Optional field

Vendor account:
Select from the list

Form Of Payment:
Agreement about the payment to the vendor.

Press NEW to create a new vendor.

Press the Supplier List button, to see a list of the 
suppliers created.

SMTP Host Setup is required in order to send e-
mails from SoftSuitCase. It is possible to have a 
common SMTP or individual SMTPs.

SMTP Setup must include what your Internet 
Service Provider (ISP) requires. If your  (ISP) uses 
the Authentication mode, enter appropriate the 
username and password.

If for example you have installed SoftSuitCase on a 
portable computer, the SMTP could change every 
time you move your computer to a new Internet 
Service Provider (ISP).

This is done by selecting the Local Settings.
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Invoice Line Products
Invoice Line Products are created or edited in the 
Menu, Administration, Maintenance and then 
Invoice Line Products.

These products must be created before you can 
invoice in SoftSuitCase. The Invoice Line Products 
makes it easier to invoice, and at the same time 
keeps the track of which accounts the Invoice Line 
Products are supposed to access.  

The following screen appears:

Press LIST to find existing Invoice Line Products.

Press NEW to create a new Invoice Line Product.

Press SAVE to save a new or edited Invoice Line 
Product.

Review of the individual fields:

ProductID:
Product code, as it is used in the invoice

Type:
N: Normal
This type is the most common, and is typically used 
when creating a new product.

H: Hidden. Must contain only net price
A hidden line is used for example. to hide an 
issuing fee. Does not show up in the Customer's 
invoice.

S: Sub line
For example, for package prices. S lines contains 
the individual elements of a package, but does not 
appear in the customer's invoice. To do this, create:

P: Head line
For example: Package tour with SAS to China.

Product Function
Specify if BSP (or NON BSP) Aircraft or the 
payment of taxes.

Types:
Is SoftFareFee: used only by SoftFares.
Is Invoice Fee: Generate only once in the invoice.
Is Default P-Line: Default P Line Invoice Line 
Product.
Copy Description to P Line: Enables or disables the 
auto copy to the P Line Description (See below).
Make Inactive: Will not show it anymore as an option 
when creating an invoice.
Auto Copy S Line Texts: Copies automatically all the 
enabled S Line descriptions to the P line 
Description.

Description
What is displayed on the customer's invoice. You 
can use the following variables:
[AUTOPRICE] : Automatically invoices from CRS 
(TST)
[AUTOPNR] : Automatically invoices from CRS 
(TST)
[FROM CITY] : Gets the city and country from the 
first segment in the itinerary.
[TOCITY] : Gets the city and country from the order's 
destination.
[AIRLINE] : Gets the airline.
Example: Airfare from [FROM CITY] to [TOCITY] 
with [AIRLINE]

Included Products : Generates an invoice Line for 
each included product.

Sales Account : The list of Sales Accounts are 
shown for your selection.

Mark up : Check,  if you want the system calculate 
the SALES PRICE from the net price. Enter an 
amount or a percentage.

Commission : Check, if you want the system 
calculate the NET PRICE from the sales price. . 
Enter an amount or a percentage.

% field : The percentage you want to use for either 
Mark up or Commission.

Net price : Any fixed net price

Sales price : Any fixed sales price

Deposit amount or  % : Enter the Deposit amount 
or the % that will be used.

VAT : There are 6 different VAT types in 
SoftSuitCase. 1-5 are percentages. P is the EU 
marginal sales tax.

Supplier Information : The supplier that is 
associated with this product. Select a Supplier from 
the LIST.
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Globalization is where you manage your cities, 
countries, etc., in several different languages.

In addition to the standard IATA cities and 
countries, it is possible to create your own, or to 
amend the information.

Most of the information can be stored in the written 
language created in SoftSuitCase

Globalization includes the following subsections:

Carriers
Cities and Airports
Countries
Currencies
Regions

Here's a description of the different screens:

Carriers

Enter the airline 2-letter IATA Code in this field. If 
you need to edit an existing airline, we must first 
find it, and then click in the gray box to the left.

Press NEW to create a new airline

Cities and Airports

Enter the City, Airport or Service IATA 3 letter 
Identifier in this field. If you need to edit in an 
existing City, Airport or Service, you must first find it 
and then click in the gray box to the left.

Press NEW to create a new City, Airport or Service.

You can also search for Cities, Airports or Services 
by selecting the language and country.

Countries

Select the name of the country in English. If it's 
called something else in another language, it is 
possible to enter it here.

Enter the country name and press SAVE

The Regions

Select the region's name in English. If it's called 
something else in another language, it is possible to 
enter it here.

Enter the Region Name and press SAVE.

Currencies

Create and maintain exchange rates for invoices 
and/ or payments in foreign currencies.
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Order Status is a feature that keeps track of what 
each order's status is.

Select Administration, Maintenance and the Order 
Status. The following screen appears:

You can edit the individual Statuses by changing 
the text under the Order State Name.

This is a LIST of types that can be used:

Quotes
Reminder sent
Active Travel
Canceled
Should Be Canceled
Awaiting refund
Under Preparation
Active Ticket
Active Quote

There must at least one of each category.

One of the Statuses must be the default. The 
Default Status will be used automatically every time 
a new Order is created.

Explanations or descriptions can be added to each.

What is the Order status?

Order status is a part of the core of SoftSuitCase. 
Normally, an Order is a quote by default and it has a 
quotation date. If your order has not been paid or 
confirmed at the latest on the quotation date, then 
the order is put in a list, from where it can be 
extended or the order can be deleted

The list is called Clean Up!

Clean Up is located under Administration.

The screen looks like this:

An order whose quotation date has expired will allow 
you to send a reminder to the customer by simply 
pressing the REMINDER button.

An Order that has a reminder sent will change its 
status to: REMINDER SENT.

An Order which is to be cancelled will change its 
status to: TO BE CANCELLED, etc.
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IEmail Text
You can set up the default text to be used in the e-
mails that SoftSuitCase sends to your customers.

Select Administration, Maintenance and then Email 
Text.

The following screen appears:

There are 4 permanent Email Texts in each 
language:

Default E-Ticket
Default Offer
Default Customer
Offer Reminder

The text can be edited by selecting Email Text Title, 
and then Editing the text.

You can insert variables in the text, by clicking the 
buttons to the right of the text where the variables 
buttons are located.

You can also include with e-mail certain 
documents.

Customer Text is used as a cover sheet, when text 
and attachments are printed to be sent to the 
customer..

You can create all the texts you need, press NEW, 
and fill in the relevant fields.

You can use default text or HTML format.

A good idea is, for example to create an E-mail 
message text to advise of a flight departure time 
change.

In some countries, it is also possible to send an 
SMS. Contact TravelOffice for more information if 
you are interested in this feature.

It is possible to attach a PDF file as a permanent 
attachment per saved Email text.

Invoice Remarks allows you to add or maintain 
standard texts in invoices.

Invoice Remarks can be found in Administration, 
Maintenance and then Invoice Remarks.
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Customer Types is used exclusively for statistics. 
To add or edit, go to Administration, Maintenance, 
Other and then Customer Types.

Edit, add or delete, and then press the SAVE

Customer Types can be used to specify different 
types of customers. It can be Business Customers 
or Private Customers. It can also be customers 
divided into different geographical areas.

The function is not used further in SoftSuitCase. 
This function is therefore only relevant for Travel 
Agents, who want to create statistical reports by 
customer type.
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There are different reasons to use the recalculate 
totals, but mainly it is used when there has been 
some problem with the database.

To access, go to Administration, Maintenance and 
then Recalculation.

These are the following options:

Customers
Update all customer totals
Update only the active customer's total

Order
Updater order total is the only active order
Updater all order totals.
Find all Orders with a total of 0

Invoice
Calculate invoice costs

For further information please contact the 
TravelOffice Help Desk.
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SoftSuitCase contains several languages. This 
section is about the printed language, the language 
that is used when something is printed to the 
customer or converted into a pdf to send by e-mail 
to the customer. Different Customers may have 
different languages,  but t each travel agent is 
responsible for the Setup and maintenance of the 
languages employed.

You can add more languages by contacting 
TravelOffice Help Desk.

To use, go to Administration > Maintenance > 
Default Reports > Setup Print Forms.

On the first tab you can see the languages that are 
installed. To install other languages, contact 
TravelOffice Help Desk.

On the subsequent tabs, all fields must be 
completed in all desired languages. It is possible to 
select a language (e.g. Swedish), and then get the 
SoftSuitCase to propose translations to other 
languages.

It is also possible to get a proposal for texts, by 
pressing the button; Get Default Text.

To translate to the selected language, just check 
the Translate boxes. 

The lower tabs: o-Customer and o-Book, are if the 
Travel Agent has a license for Web services and/or 
then Online Booking Systems.

Variables.
The variable buttons insert a variable in the text at 
the point where the cursor appears when the 
button is pressed, for example: {UIDName}.

Text appearing in square brackets [...], is NOT 
translated.
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GENERAL
The General tab contains the general information 
used in invoices, travel itineraries, etc.

It is possible (only on the General tab) to have 
different information per section, if for example the 
departments have different address.

In section COLORS, one can select colors of the 
boxes and lines and the text labels.

In the General tab, for the VAT settings, you can 
specify whether you want the private customers to 
see the VAT.

Upload logo:
Main logo (770x230) for use by all prints.
Logo of the left (60x120) for use by all prints.
Logo of the right (60x120) for use by all prints.

When all the pages are set up, it's a good idea to 
print the different forms out, and see if it looks as 
desired.

Set Reports to Local
If you have installed SoftSuitCase on a laptop, it 
may be a good idea to select this function.

To use, go to Administration > Maintenance

After the reports are set to local, they are copied to 
the local hard disk.

Copy reports
To use, go to Administration > Maintenance > 
Standard Reports > Get new version.

Select all and press Update reports.
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TravelOffice is based in an old 
warehouse in the heart of 
Copenhagen.

If you wish to hear more about 
our solutions for the travel 
industry, our hosting services, 
or just want to see our unique 
offices, you are always very 
welcome to come to visit.

Our courses in Denmark are 
also offered in the old 
Warehouse in Nytorv.





After an employee or user has been created, they 
may login to SoftSuitCase.

Enter the Username and Password.

Select the database
Usually Travel Agencies will only have one 
database but larger systems can have more than 
one.
 
Select Language
Select the language to be used as the display 
language in SoftSuitCase.

We currently support the following languages:
Danish
Swedish
English
German
Spanish.

Automatic Login
If we want to SoftSuitCase in the future to log you 
in automatically,  just check the Save User 
name/Password box.

Local Reports
If you wish to use local reports at eg. a laptop, just 
check the box.
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Translate User
This function is only used if the user is authorized 
by TravelOffice to install or maintain a new 
language.

Get System Password
Used by TravelOffice for troubleshooting.

Local Settings
This should only be used in agreement with 
TravelOffice Help Desk.

Change user
If SoftSuitCase has been set up to make automatic 
login, you must press the blue button at the top of 
the main screen to change your login:
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1. 

2. 

3: 

4:

5: 

6: 

The Menu.
See the description for each menu item elsewhere 
in this guide.

View menu.
Using this menu, you can choose to see the main 
menu,  calendar, etc., depending on how  your 
screen resolution is set up.

Tool Bar:
Displays the features in the top of the screen

Status Bar:
Displays the status bar at the bottom of the screen

Hotkeys:
Displays the Help menu with the most common 
features, on the right side of the screen

Calendar:
Displays the calendar at the bottom of the screen

Info list:
Displays information on sales etc. on the right side 
of the screen

Open a NEW Order

Select a printer.

Select the currency

Select primary PRINT language
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*1 *2

*3 *4 *5 *6 *7 *8 *9 *10 *11

7: 

8: 

9: 

10: 

11: 

The user who is logged in, as well as the user 
privilege number in parentheses.

Thename of the database in use

Help

Change Login

Close SoftSuitCase

A screen shot showing SoftSuitCase with 3 open 
Orders, as well as all the other features opened. 
This requires a full HD screen resolution.

It is possible to click on the help buttons in the 
Hotkeys to the right of the screen.



Alternatively you can press F4 to create a manual 
PNR

3. Create or select a customer.

Enter customer name, and press Enter. If you 
previously had a customer with this name, a list will 
be displayed will all the existing customers with that 
name:

If you wish to use an existing customer, double click 
the gray box to the left of the customer's name, or 
press Enter when you have selected the customer.

Create new customer:
If you want to create a new customer,  just fill in the 
fields with the customer's name, address, phone 
numbers, etc.
Remember the e-mail address.  It is possible to enter 
several e-mail addresses separated by; or a new 
line.

4. Check airline and destination

You must manually check that the airline and 
destination are correct. If not, they must be 
corrected. They must be corrected.

5. Select Offer Date

Offer Date is the date on which the customer 
requested the reservation without having paid or 
approved it.

6. Attention, Customer references and language

If your customer wants another name as the contact 
then select the Attention Name.

If the customer wishes to have their invoices in 
another language other than the local language, then 
select the appropriate language.

7. SAVE the Order

Press Functions and Save Order (or F2)
The order is saved and assigned a unique Order 
Number

When you have logged in you get the following 
screen.

Orders

SoftSuitCase revolves an Order. An order can, 
among other things. contain:

A customer
One or more manual PNRs and/or one or more of 
the PNRs from Amadeus, Sabre or Worldspan
Passengers
Segments
Airline Tickets
Invoices
Payments
Vouchers

How to create an order from a PNR?

1. Transfer PNR from Amadeus, Sabre or 
Worldspan

2. Go to Functions and then to Transfer from CRS 
(Or press F3)

Then you will see the following screen:

Press CREATE NEW next to the PNR you wish to 
use to create a NEW Order.

PNR is opened in a NEW order.
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How to create a Manual Order?

1. Select Functions and then New Order.

2. Fill in the departure Date, Airline and Destination. 
Leave the PNR box empty.

3. Create or select a customer.

Enter customer name, and press Enter. If you 
previously had a customer with this name, a list will 
be displayed will all the existing customers with that 
name:

If you wish to use an existing customer, double click 
the gray box to the left of the customer's name, or 
press Enter when you have selected the customer.

Create new customer:
If you want to create a new customer,  just fill in the 
fields with the customer's name, address, phone 
numbers, etc.
Remember the e-mail address.  It is possible to 
enter several e-mail addresses separated by; or a 
new line.

4. Select the Offer Date

Offer Date is the date on which the customer 
requested the reservation without having paid or 
approved it.

5. Save order

Select Functions and Save Order (or F2)
The order is saved and assigned a unique Order 
Number.

6. Create the Passengers, Segments

NOTE:
The order must be saved before the passengers 
and segments can be created.

How to add a PNR to an order?

1.
Open the Order, if it is not already open.

2.
Transfer PNR from Amadeus and Worldspan

3.
Go to Functions, and select Change/Add PNR to 
Order.

The following screen will appear:

Select the PNR, you wish to use and press Add 
PNR.

Close the dialog box.

4. PNR field in order card is now MORE!, and all 
segments and passengers appear. Use the down 
arrow to the right of the PNR field to change PNRs.

How do you change a PNR in an order?

This can only be done if there aren't any issued air 
tickets in PNR.

Follow the instruction in the above example, but 
instead press CHANGE in the dialog box.

This means that a new PNR is attached to the order, 
and the old PNR is released, and can be deleted or 
be associated with another Order

How to add a manual PNR to an order?

1. Open the Order, if it is not already open.

2. Go to Functions, and select Add Manual PNR to 
Order.
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Segments on an order can consist of one or more 
of the following elements (Type is in parentheses):

A flight from a PNR or a manually created flight 
(AIR)
Hotel or Car from PNR or a manually created Hotel 
or Car (HTL/CAR)
A Tour from a PNR or a manually created tour 
(TUR)
Transfer (TRF)
Train (TRN)
Ferry or cruise (SEA)
Fee (FEE)
Golf (GLF)
Complete package (PKG)
Other (OTH)
Option (OPT)

How do you change an existing segment?

1.  Select the Itinerary tab of an order, where all the 
segments are listed.

2. Double click in the gray box to the left of the 
segment you want to change.

3. The following screen appears

4. Enter the required information and press SAVE

How to delete an existing segment?

1. Select the Itinerary tab of an order, where all 
segments are listed.

2. Click in the gray box to the left of the segment you 
want to change.

3. Press DELETE

How to create a new segment?

All manually created segments is identified as M for 
manual

1. Select the Itinerary tab of an order, where all 
segments are listed.

2. Press the NEW icon on the left side (White Paper)

3. The following screen is displayed

4. Select a type of the segment you want to create, 
and then press Enter.

5. Fill in the required information and press SAVE.

What do you do if the segments are sorted incorrectly 
in the Itinerary?

Each segment has a sorting date by which segments 
are sorted in the Itinerary.

Flight segments are sorted by departure date and 
time. Other segments are sorted by various criteria.

1. Open the segment that is sorted incorrectly.

2. Enter the correct sorting date and time (black date)

3. Press SAVE

24 SOFTSUITCASE 2010 - USER MANUAL - VER. 7



Vouchers can be created from existing segments.

After the segment is created and saved (for 
example, as in the example above), press  Create 
Voucher .

The following screen appears:

1.
Select or create a Supplier. See the section on 
Suppliers, and how to create a new Supplier.

2. Fill in the required fields.  Enter the details of 
Present To:  if the Voucher should be shown/given 
to other than the Supplier (for example, directly to a 
hotel)

3. Select Form of Payment (FOP), and enter if so 
required an amount.

4. Fill in the Voucher Text with the value of voucher, 
what is included and what is NOT included, for 
example, how many rooms, what type, is breakfast 
included, etc.

5. SAVE Voucher

Voucher may look like this:

Send the Voucher to the supplier

Press the Voucher Email. Then press New Booking.

 The following image shows:

The text is generated automatically from the 
information contained in the Order, but can be 
corrected manually.

Press the SEND MAIL

Be sure to correct the segment's status to RQ, 
pending the reply from the supplier.

See WEBServices for the supplier's ability to provide 
an automatic reply.
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How do you fix a passenger's name?

Go to the reservation system, and enter the correct 
passenger name in the PNR. Then transfer the 
PNR to SoftSuitCase again.

If there is other information that must be corrected, 
press the Passenger tab of the Order.

1. Double click in the gray box next to passenger's 
name.

2. The following dialog box appears:

3. Enter the required information and press SAVE.

Remember that a passenger is not the same as a 
customer!

How to create a new Passenger.

1. Press NEW in the Passenger tab.

2. Fill in the required information

3. Press SAVE

Dates of Birth and FF Cards are usually  
downloaded automatically with the PNR.

Contact details are only for your own use, and have 
no further function in SoftSuitCase.

Attention: Names, as well as Passengers can be 
saved in SoftSuitCase.

It is possible to store information about individual 
passengers and contacts during using the Attention 
in the Order:

Using the following screen:

Open, edit, save and delete Attention Names,  

It is also possible to store information about 
individual passengers and contacts using the 
Attention option in the Order:
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There are several places in SoftSuitCase where 
you can enter remarks. Some remarks are intended 
to be shown to the Customer and others are solely 
for internal use.

Customer Remarks
These remarks follow the customer, in other words 
they are available the next time the customer 
orders another trip.

Customer Remarks are entered and edited in the 
Customer Form (Ctrl + F1)

Customer Remarks can also be entered in the 
Order, selecting the REMARKS tab and then the 
Customer tab.

Order Remarks
These remarks follow an order, and are entered in 
the Order, selecting the REMARKS tab and then 
the Order tab.

PNR Remarks
Are entered in the Order, selecting the REMARKS 
tab and then the PNR tab.

Tracking
SoftSuitCase includes a tracking feature that stores 
information about e-mails sent to the customer, 
invoices, itineraries, tickets and much more.

The Tracking Form can be accessed from the Menu 
File > Tracking Show.

Press › S to see the contents of an e-mail message. 
Press the icon in the Attached box to see what 
attached documents were sent.

Queues
It is possible to put an order in the Queue to 
yourself or to another employee of the Travel Agent.

The Queues Form can be accessed from the menu 
File > Add to Queues.

Fill in the required information and press SAVE.

What is in the Queue can be viewed by selecting 
Menu File > Queue Show
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How to create an invoice or offer?

1. Select Menu File > Open Invoice (or Ctrl + I)

The following screen is shown:

2. Create Invoice Lines

Place the cursor in the Product box. If you know the 
Product Code, you just enter it. If you do not know 
the Product Code, you can type * in the field. Then 
press Enter.

If you do not know the Product Code or enter a 
Product Code that does not exist, the following 
screen will appear:

Double-click the mouse on the gray box to the left 
of the Product you wish to use, or when selected 
just press enter.

Fill in the required fields and press enter or tab to 
jump to the next field.

Description of each field in the invoice line:

L: Line type
N: Normal
H: hidden line
S: Hidden SUB line
P: Main Line

Product:
See above

Description:
Text about the reason for the invoice line. Can be 
changed

Document:
Any document number (Ticket, insurance, voucher.)

Units:
Number of units

Net Price:
Net Price of the invoice line. It will not be displayed to 
the customer. Negative sign (-) is in front of the 
amount

Sales Price (Unit Price):
Sales price which will appear on the customer's 
invoice.

(V):
VAT (Sales Tax)
See codes in the Setup section.
0 = no sales tax.
1-5: individual tax rates
P: EU Marginal Tax

When all the Invoice Lines are filled in, press the 
SAVE icon, and the Invoice Line will be added to the 
Invoice or it will replace an Invoice Line if it was 
edited.

You can create as many invoice lines, as desired.

If the sort order is wrong, this can be corrected by 
selecting the Invoice Line (click once in the gray box 
to the left), and then use the arrow buttons in the left 
bottom to move the Invoice Lines.

If something needs to be changed it can also be 
changed in the table itself.

The invoice can be extended to the screen's height 
by typing Ctrl + Z

If you are using S + P Lines, texts from the individual 
S lines are transferred to the P Line by pressing 
button the Transfer Text icon (copy icon) located at 
the bottom of the screen.

After the texts are transferred to P Line, it is possible 
to manually edit the text, and correct it as you wish.
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3. Issue Date and Due Date.

The Issue Date is usually the current date and the 
Due Date is usually the Offer Date from the Order. 
Both dates can be changed manually.

Customize dates, if necessary.

4. Deposits.

If the product  requires a Deposit then it can be 
generated automatically when the Product is used.

It is also always possible to add one or more 
deposits manually. Each invoice has the option of 
up to 3 deposits with different due dates.

5. Diners Travel Account and AirPlus

If you have a license for a Diners Travel Account or 
AirPlus Account and the Customer has one of these 
accounts, then the Invoice can be checked as such. 
The invoice will then be put in a list to be sent to the 
Travel Card Company, the next time the transfer is 
run..

6. Issue the invoice or Offer

Press the Printer icon to issue an invoice (or F12). 
Create an Offer from an Invoice by selecting Offers 
and Invoices and then Create an Offer from this 
Invoice (or F11)

Offers and Invoices.

If we issue an invoice, the program automatically 
assigns the next invoice number. If you issue an 
Offer it takes on the Order Number plus the next 
available Offer Number from 01 to 99. It is possible 
to issue up to 99 Offers, all of which can be open 
simultaneously.

On the other hand, it is only possible to have one 
open invoice at the same time. If you want to issue 
a new invoice, you must first close the old Invoice 
using the Close Current Button in the Order Form.

An invoice will be  a Credit Note if the total amount 
is less than 0

Change Customer's Name on an Invoice

It is possible to manually change the customer's 
name and address on each invoice. If a customer, for 
example, wants the Invoice billed to the company or 
vice-versa.

This is done under Menu Edit › Change Address in 
Invoice.

Delete Invoice Lines

You can delete Invoice Lines by double-clicking  the 
gray box to the left of each Invoice Line and the 
pressing the Delete Key on your keyboard.

You can delete all the Invoice Lines by going to Menu 
Edit › Delete all Invoice Lines.

Copy of Invoices

It is possible to copy all the invoice lines of an invoice 
to a new Invoice or Credit Note. This is done going to 
Menu Edit › Convert or Copy old invoice.

You can copy from this order's invoices, but also from 
other order invoices.

You can also create the following going to Menu> 
Offers and Invoices:

Create a new Offer from this invoice
Create a new Offer from this offer

Change an Offer into an Invoice.

If you have created one of more Offers to one of your 
Customers and the Customer accepts one of the 
Offers you can easily change into an invoice, by:
 
1. Open the original Offer

2. Press F12

Open and Closed Invoices

Each Travel Agency determines in the Setup when it 
wants an invoice to be closed. You can choose 
between:

When Issued
At midnight
When paid or received a deposit
Manually Closed.

As long as an invoice is open, you may edit it. If it is 
closed, you must issue a Credit Note to cancel it out 
and then create a new Invoice.
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After an Order has been created, and one or more 
Invoices have been issued, what happens when the 
Customer chooses to pay!

How to record a payment in SoftSuitCase?

1. Open the Order, which has the Invoice or 
invoices the Customer wishes to pay.

2. Select Menu File > Payment (or Ctrl + P)

The following screen appears:

3. Select method of payment (Cash, Bank, etc.)

4. Choose Payment Type
Pay all invoices, if you are going to pay all 
outstanding invoices, otherwise select Pay some 
Invoices, and select the invoice or invoices you 
wish to pay. Both these Payments Types involve 
paying the total outstanding balance.

If the amount of the payment is not the same as the 
outstanding balance of the invoices selected then 
you must  either select Invoice Deposit, Credit or 
Debit Payment or Customer Deposit. 

5.Select Currency
The payment amount must be in the same currency 
as the invoice. If the customer chooses to pay in 
another currency, the invoice must be crossed with 
a Credit Note, and a new Invoice must be issued in 
the correct currency.

6. Select the Payment Date
Normally the current date, but the payment date 
may be changed if the user has rights to the

7. Press SAVE

Explanation of the elements in the Payment Form.

Pay All Invoices
Pay all the customer's invoices.

Pay some invoices
Pay some of the customer's invoices. Select the 
individual invoices.

Invoice Deposit
Pay a deposit for an invoice.

Customer Deposit
Pay a customer deposit (Advance payment).

Invoice Credit or Debits
Credit or Debit an Invoice.

Cross Deposits
Cancel out deposits. The resulting balance must be 
0.

Cross Invoices
Cancel out invoices with Credit or Debit Notes. The 
resulting balance must be 0.

Use Payment ID
Used currently only for Travel Agents that have 
SoftFares.

Payment Date
The date on which payment was made.

Payment Account
The account to which payment is made.

Amount Received
The amount or paid. For the payment, the amount 
must be negative.

Currency
The currency of the payment which must be the 
same as the invoice currency.

Customer Outstanding Invoices
View all CUSTOMER'S outstanding invoices, etc.

Order for outstanding invoices
View all ORDER'S outstanding invoices, etc.

All Order invoices
View all the Order's invoices whether they are 
outstanding or not.

Payments Receipts
Press to print a receipt.

Close after payment
Close the payment form after the payment is 
complete.
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How to make a Customer Deposit payment in 
SoftSuitCase?

1. Open an Order of the Customer that has made 
the Customer Deposit.

2. Press Menu File and then Payment (or Ctrl + P)

3. Select method of payment (Cash, Bank, Olympic 
Games.)

4. Check Customer Deposit

5. Enter the amount of the Customer Deposit in the 
Payment Amount Received.

6. Press SAVE

Customer Deposits will be entered in the Payments 
Table as 'D'.

Invoice with a total of 0,00. (Cancelled invoices)

To remove invoices with a total of 0,00 from the 
customer's account statements, these must also be 
paid. This is done by paying them with a 0,00 
amount.

How you pay back a customer in SoftSuitCase?

1. Create a Credit Note for the amount you wish to 
pay back. This is done creating an invoice, except 
that there is a minus (-) in front of the amounts.

2. Press File and then Payment (or Ctrl + P)

3. Select method of payment (Cash, Bank, Olympic 
Games.)

4. Choose payment type
Pay all Invoices, if there is only one invoice, 
otherwise select Pay some Invoices, and select the 
invoice you wish to credit.

5. Press SAVE

How do you register an invoice payment deposit in 
SoftSuitCase?

1.  Open the order, which has the invoice you wish 
to pay.

2. Press Menu File and then Payment (or Ctrl + P)

3. Select method of payment (Cash, Bank, Olympic 
Games.)

4. Check Invoice Deposit.

5. Select the invoice.

6. Enter the amount of the Invoice Deposit in the 
Payment Received.

7. Press SAVE
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A new Customer is created easiest with an order. 
See the section on creating Orders.

How do you create a customer, without creating an 
order at the same time?

1. On an empty Order, Select Menu File and the 
Open Customer (Or Ctrl + F1)

You will then see the following screen:

2. Press NEW (White Paper) icon button

3. Fill in the required information

Select a customer account
Enter the credit max (0 if no credit)
Please enter the VAT number, if it is a business 
customer
Enter the AirPlus or Diners Travel account if they 
are members.

Enter the Credit Days:
0 = no credit
5 = 5 days after invoicing
-45 = 45 days prior to departure

If you do not write anything in the customer 
number, the primary phone number will be used or 
press the 'A' button if you want SoftSuitCase to 
auto generate a customer number.

4. Press SAVE

How do you find a customer?

1. On an empty Order, Select Menu File and the 
Open Customer Form (Or Ctrl + F1)

2. Press SEARCH (Binoculars) icon button

3. Enter the first part of the customer name

4. Press ENTER

5. Select a customer from the list

6. Enter the required information

7. Press SAVE

AirPlus and Diners Travel Account

If the Travel Agent has an agreement with AirPlus 
and/or Diners Travel Account and the Customer also 
has one of these accounts then select the Accounts 
tab and enter the required information.

Other Credit Cards

If the Travel Agent has a license for SoftSuitCase 
Credit Cards, there is a possibility to individually 
enable the Credit Cards the Customer can use.

Select the desired payment options and press SAVE.
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The system uses the PRINT LANGUAGE, both in 
text and in PDF files. In this case English is used.

In some countries, it is also possible to send a brief 
TEXT MESSAGE from the system.

Explanation for each field:

From: the sending e-mail address. Setup  for the 
user or employee.
To: The recipient e-mail address

Subject: Auto text from Email Text setup. This can 
be changed

Attach: The attached files.

HTML: Do HTML encoding in e-Email. This requires 
a thorough knowledge of HTML.

SMTP HOST & Port: SMTP Host and Port No. for 
sending E-mail.
See the section on SMTP

Language: The selected language. Coming from 
the Order, but can be changed here if so required.

Invoice/Offers: Attachment of Offers and Invoices. 
Normally already specified in the Email Text but can 
be changed manually.

Payment Receipts: Payment Receipts

SMS Phone: The phone number to send the SMS 
to.

Translate: Any text in the text field can be translated 
to another language with BING Translator.

Select Other Email Text
Other (than quotes and airline tickets) individual E-
mail message text that is created by the Travel 
Agent. It may be explanations about  time changes, 
reminders, etc..

Print or Email
F2 sends the e-mail to the customer. F12 gives you 
the option to select a printer, and then to print the 
required documents along with a cover letter.

Voucher
Any vouchers printed or sent usually with e-tickets.

SoftSuitCase is fully integrated with E-mail, so it is 
possible to send all documents to the Travel 
Agent's customers by e-mail.

When an order and invoice is created, it is sent to 
the customer. This is done from the Menu > 
Functions > Email/Print, or, by pressing F12.

Then you will see the following window:

From this window, Invoices, Offers, e-tickets etc. 
can be forwarded to the customer.

In the example below, we will send an Offer e-mail 
to a new customer by pressing F3 (Offer):

The text that appears is the Default Offer text that 
was created in the Email Text Form for this 
purpose. The text can be edited if so required.

As you can see, there is a Travel Itinerary and 
Invoice 26247 attached. These documents are 
attached to the e-mail as PDF files.

The text uses the Offer Date, and explains to the 
customer that this is an offer which must be paid at 
the latest on the 08 SEP, in order to be confirmed.

It can have additional files attached.
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e-tickets

If your system is set up for it, all tickets are issued 
(Either by yourself or by another Travel Agency) on 
that PNR in Ticketab.

How to print e-tickets in SoftSuitCase?

There are several ways to print e-tickets in 
SoftSuitCase. The easiest is to press Menu 
Functions > Email/Print (or F12).

The following window then appears:

Select e-tickets (and possibly other documents) and 
press Print Checked Items or (F12).

They can also be printed directly from the Ticket tab.

How to send you e-tickets by email?

1. Press Functions > Email/Print (or F12).

2. Press the Default E-ticket text (F3)

3. Select any other documents you want to attach.

4. Edit the text if so required.

5. Enter or add email address

6. Press Send Email (or F2)

Cover letters for customers

It is possible from SoftSuitCase to send cover 
letters to customers either in an e-mail or as a 
printed cover letters.

The letters will be sent from the customer Form. 
Go to the Customer Form, and find (or create) the 
desired customer. Press the > Letters > button.

Select the desired mail in the drop down box › 
Select Other Email text ~. Make any necessary 
corrections, and then send or print.

This information is stored in the Tracking. It allows 
you to see later   which customers have chosen 
to buy travel, after they received a catalog from 
you.
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There are many different ways in which one can 
search for an Order, a Passenger or a Customer in 
SoftSuitCase. The most used is the Search window.

The Search window can be found under Functions 
> Search or the function key F9.

Searches can be combined as desired. In this case 
we are searching for a passenger with HANSEN as 
a surname and whose name could also include 
Hansen and who is travelling to DXB.

Once the results appear, move the cursor with 
mouse or arrow keys, to the desired customer, and 
then press ENTER to open the order.

Explanation of each field:

Include Orders without Passengers.
Select this if you want to search for Orders without 
passengers, like group Orders.

Include Filed Orders.
Also search Archived Order.

Last Search
Repeat last search

Passenger name
Passenger name e.g. from PNR. Searchable >*< or 
>%> as wildcards. For example, *GAR* will display 
all of the passengers where the GAR is part of the 
name, regardless of the location.

Customer name
Customer name. Searchable with >*< or >%> as 
wildcards. For example, *GAR* will display all of the 
passengers where the GAR is part of the name, 
regardless of the location.

Departure date
To search only on this date or later.

Destination
IATA 3-letter destination code

User
The user's login code that created the Order

Carrier
2 letter IATA airline code.

The following codes can both be used to filter the 
search, but will also appear next to each passenger:

A: Active (the trip is active)
T: Ticket Issued (issued air ticket)
V: Void (the trip is cancelled)
P: Paid (the trip is paid)

You can move between pages, if there are more 
results than can fit on a page.

Other ways to search for an Order.

1. In an empty order, enter the Order Number and 
press ENTER

2. in an empty Order, enter the PNR and press 
ENTER

In Menu Functions there are 3 other Order search 
possibilities:

1. Search by Invoice Number.

2. Search by Airline Ticket Number.

3. Search by Invoice Total Amount.
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In SoftSuitCase, all new Orders are Offers. If the 
Customer has Credit, when the Customer accepts 
the offer, the Order Status should be changed to 
ACTIVE TRAVEL. If the Customer does not have 
Credit, when the Customer has paid or made a 
deposit, then the Order Status should be changed 
to ACTIVE TRAVEL.

If an Offer Date has passed without the trip being 
accepted or paid, the Order Status should be 
changed to CANCELLED or DELETED.

This feature is called > Clean Up <, and can be 
found in Menu > Administration > Clean Up.

The following window appears:

The list will show all the Orders that have Offer 
Dates that have expired, because either they have 
not been accepted or paid on time, as well as the 
Orders where the Customer has cancelled.

See the section on › Order Status ‹ for information 
about the setup of this part of the SoftSuitCase.

If the Offer has expired, the Order Status will be 
OFFER. If you already have moved for the trip will 
be status OFFER ADVANCED. If the trip is 
cancelled, then the Order Status should be TO BE 
CANCELLED

At the bottom of the screen, there are some 
functional buttons, where there is a possibility to 
open all orders or send reminders to all expired 
trips.

You can also process the Orders individually.

To open an Order from the list
Press OPEN

To send a Reminder to a customer
Press REMINDER

To permanently Delete an Order
Press DELETE

If you press the DELETE, it will change the Order 
Status to cancelled, and the Invoice will be reset. 
If there is more than one invoice, or if there have 
been payments in the Order, these must be 
deleted manually.

If you use the WebService it will also usually also 
deleted the PNR

An order that moves will move the Offer Date 1-2 
days from the day, and the status will be changed 
to OFFER ADVANCED

It is important to CLEAN UP. It is recommended to 
use this feature at least once a day.

Clean Up for Missing Payments.

Clean Up for Missing Payments, shows a list of 
Orders, that have not been paid on time.

Due Date
Press Due Date, to change the date of the last 
payment.

Balance
Press Balance, to print or export a Customer's 
balance.

Open
Press Open to open the Order.
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SoftSuitCase offers a wide variety of reports. These 
are selected from SoftSuitCase Report Generator:

Press Functions > Reports (or F11).
The following window then appears:

The individual reports are selected in the menu at 
the top of the window.

After the report is selected, there is the possibility to 
choose what and how you want the report to 
display.
 
Generally, you will have these options, as in this 
example:

Box to select fixed date periods
Or you can select directly other date periods.

Show Chart
View the report as a Chart

Hide Details
Do not show the details, only show totals

User
All users or a particular user

Department
All departments or just one particular department

Currency
All reports are displayed in the currency that is used 
in each Order, but converted to the selected 
currency.

Period
From and To dates

Period selected by:
The date of issue or the date of departure

The report's criteria can be different, depending on 
which report is selected.

After all required options have been selected 
pressing Run Report.

The report is displayed on the right side of the 
window. The report contains the following menu 
options:

Eksporter. 
See later in the section on Reports about the 
possibilities for export.

Print
Print report

Update
Refresh report

Expand
Expand the report, so that for example it can be 
selected between the individual employees or 
users.

Navigate
Go back and forth in the report

Go to
Go to page no.

Zoom
Makes the report more or less

Update Report.
Press the Update at the bottom of the window. 
Then SoftSuitCase will find the latest version on 
our main server and reply back:

A new copy of the report:......... is now copied to 
your system!

If the report does not exist when you try to run it, 
the program retrieves a copy of the system 
automatically..
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Export of Reports
All reports can be exported in the following formats:

Adobe Acrobat (PDF file)
Microsoft Excel (XLS file)
Microsoft Excel Data Only (XLS file)
Microsoft Word (DOC file)
RTF (RICH TEXT file)

If you want to continue working with a report in 
Excel, it is recommended to use Data Only.

Export of Customer e-mail addresses to an external 
e-mail system.
All customer's names and e-mail addresses can be 
uploaded to a file, to be used by an external e-mail 
system for newsletters etc.

Please see note relating to sending unsolicited e-
mail messages to your customers.

New Reports
SoftSuitCase is constantly updated with new 
reports.

The new reports will automatically appear in the 
report menu when they are created, and the new 
report be downloaded automatically to your report 
directory first time it is used.

Other reports
TravelOffice can also develop other reports if you 
so require. Please Help Desk for more information.

Crystal Reports
Each Travel Agency can even develop their own 
reports, or further develop existing reports  by 
acquiring the program > Crystal Reports <‹.

New and revised reports must be saved under 
different names and in a different directory than the 
default reports in SoftSuitCase, if you want to avoid 
them being overwritten.

Please contact TravelOffice for pricing of Crystal 
Reports.

User Reports
It is possible to change existing reports, if you 
have a little technical skill.

When you have selected a report at the bottom of 
the window you will see a > Formula < button.

If you press it you will see the following screen:
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Enter the required 
formula.

It is necessary to 
know a little about 
the SoftSuitCase 
database structure, 
in order to be able to 
use these features.

When you are 
finished, you can 
specify a name at 
the bottom, which 
then saves the 
report for future use.

Search for a saved report.

To locate the saved report, you must press > User 
Report < at the top of the screen, and select the 
saved report.
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SoftSuitCase regular Reports.

The following reports are standard:

Invoice
Itinerary
Balance
Customer Letter
CustomerLetterC
Deposit
Voucher
e-ticket

These reports are updated occasionally. It is 
possible to get a new copy by selecting Menu > 
Administration > Default Reports > Get New 
Version, and then you can choose which reports 
you want to update or all.

Background colors, Logo, etc.
Background colors, Logo and text in SoftSuitCase 
standard reports can be changed in Menu > 
Administration > Maintenance > Default Reports > 
Setup Print forms.

See the section of how to Setup Print Forms.

40 SOFTSUITCASE 2010 - USER MANUAL - VER. 7





SoftSuitCase does not come with its own 
accounting system (Finance System) per se, but 
contains a large number of export features that 
make it possible to transfer data to external 
accounting programs, including Microsoft C5.

It is possible to transfer the following data:

Invoice Lines
Customer Transactions
Payments
Costs or Expenses
Credit Transactions

Invoicing
Each invoice performs a series of transactions in 
the accounting system. Sales are posted to the 
Sales Account and posted to a Customer Account.

Payments
Each payment pursuant to a transaction in the 
selected Payment Account (usually a bank or cash) 
also offsets the Customer Account.

Each also uses the opportunity to post the cost in 
SoftSuitCase.

Purchase
Every purchase generates a transaction on the 
selected payables account, and an offset 
transaction in the Supplier Account.

Most use SoftSuitCase as a transaction module in 
connection with their accounting program.
This means in practice that all customer 
transactions are controlled from SoftSuitCase, and 
posted to only one customer account in the 
accounting program.

Export module
Export module is located in Menu Administration > 
Accounting > Export Accounting Data.

 

There are three different export options. When data 
is exported it is assigned an Export Number, so there 
is control over what and when it was exported.
 
The following can be exported:

Invoices
Export data from the issued invoices. You can 
choose to Export only Closed Invoices or all Invoices, 
which are then closed once they have been 
exported.

Payments
Payments made to the Payment Accounts.

Expenses
Bills from suppliers

Explanation for each field:

Search
It is possible to search for an Invoice Number

Invoice/Payment/Expenses List
List of transactions that have not been exported

Exported List
List of exported files with their Export Number.

Re-Export
Provides the ability to re-export a previous export file 
from the system.

Financial system
Select the desired Accounting System that is to 
receive the exported data. You can select one of the 
following:

C5
Navision
C5 Windows 7 or 8 versions
Navision 2009

Most other accounting systems will work, if you 
choose C5.

Contact Help Desk If there are problems with the 
export to your accounting system.
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Below there is an example of exported data from SoftSuitCase:

Invoices:
10.09.2012,80295,D,88888888,"Bettina Lundgaard - OrderNo 70035",15474.00
10.09.2012,80295,F,105,"Bettina Lundgaard",-15428.00
10.09.2012,80295,F,105,"Bettina Lundgaard",-46.00
10.09.2012,80296,D,88888888,"Helmuth Nissen - OrderNo 70037",9075.00
10.09.2012,80296,F,105,"Helmuth Nissen",-9029.00
10.09.2012,80296,F,105,"Helmuth Nissen",-46.00

Payments:
10.09.2012,"Payment for 69260(79292)",D,88888888,"Helle Nielsen",-37474.00
10.09.2012,"Payment for 69260(79292)",F,6400,"Helle Nielsen",37474.00
11.09.2012,"Payment for 69913(80148)",D,88888888,"Henriette Hansen ",-11960.00
11.09.2012,"Payment for 69913(80148)",F,6400,"Henriette Hansen ",11960.00

Expenses:
05.09.2012,33227799,97304,"INCA Tours - OrderNo 69912",3678.50,DKK,1.0000
05.09.2012,,97304,"INCA Tours - OrderNo 69912",-3678.50,DKK,1.0000
05.09.2012,511560,16252915,"TUI - OrderNo 69912",-66.00,EUR,7.4500
05.09.2012,,16252915,"TUI - OrderNo 69912",66.00,EUR,7.4500

See our description > ACCOUNTING EXPORT <, which can be downloaded from the TravelOffice web site
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It is possible to list all of the supplier's expenses in 
SoftSuitCase, and then transfer them to the 
accounting system.

As described previously, SoftSuitCase calculates 
the expected profit on each trip that is sold. This 
happens on every Invoice Line.

If you use this system, you will be able to see the 
real costs of each individual order.

This can be found in Menu > Administration > 
Expenses.

Each Supplier Invoice entered in the system. If a 
vendor invoice contains bills that must be shared in 
addition to several orders, enter these separately.

Date:
Date of receipt of the Invoice from the Supplier

Order number:
The order number.

Invoice Number:
Select in the drop down box the invoice that uses 
that expense..

Supplier Name
Select the supplier from the drop down box above 
the Supplier Name. You can only select suppliers 
that have already been entered into the 
SoftSuitCase.

See under Setup, suppliers.

 Supplier Number
Comes automatically when the supplier is selected 
in the drop down box

Expenses Account
Select accounts for the cost in the drop down box 
above the Expenses Account

Supplier Invoice
Enter the invoice number of the invoice that you 
received from the supplier.

Vat Amount
Enter the VAT amount from the cost.

Currency
Enter currency

X-Rate
The current exchange rate. This can be changed in 
the Currency form.

See Globalization in the Setup section of this 
manual.

Press SAVE to save the line.

It is possible to change in the posted line by 
double-clicking the gray box to the left of the line 
until it is posted. Then it is no longer possible to 
change in the line.

See cost per order.

When all Expenses have been entered, it is 
possible to see the cost per order.

Choose in the Menu > Administration > Accounts > 
Check Expenses for this Order.
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Groups & Allotments in SoftSuitCase, offers Travel 
Agencies the option to create groups and 
allotments, and then control the number of sold 
travel per group. In addition, the system can be 
used for names, reporting, etc.

Amadeus, Sabre and Worldspan
Groups & Allotments can be created manually, or 
set up as group bookings in Amadeus, Sabre or 
Worldspan.

Booking from Groups & Allotments
It is possible to book online from the individual 
orders from the various groups. It is possible to 
book from multiple groups on an individual order. It 
is also possible to combine individual flight 
reservations with the booking of the groups.

Creation of GROUP MASTERS
Before booking from groups, they must be created 
as GROUP MASTERS.
This is done in the same way as creating a regular 
order.
GROUP MASTERS can be created with a PNR rom 
a reservation system, or as a manual PNR.

You cannot create PASSENGERS in the GROUP 
MASTER Order.

When the order is created, the status of the order 
changes to GROUP MASTER. This is done in the 
CRS dropdown box:

When the GROUP MASTER is selected, specify 
the group name, and number of seats:

Then press SAVE!

After the GROUP MASTER is saved, create the 
associated invoice lines.

Enter the INVOICE, pressing as usual (CTRL + I), 
and create the desired Invoice Lines. Use the 
units, if it is necessary (for example, 7 nights in a 
hotel at 500,-DKK). Otherwise, enter units as 1.

The invoice cannot be saved as invoice, it is saved 
as an Offer. Press ESCAPE or X, when the 
desired lines are created. They shall be saved to 
the Offer.

Both the created segments and the resulting 
Invoice Lines will be transferred to the orders, 
either booking from (Both OFF-and ONLINE).

GROUP MASTER Options
It is possible to use GROUP MASTERs booking 
OPTIONS. For example, for a single room 
supplement, or an excursion.

Create a GROUP MASTER as described 
previously. Add Segments, optionally and if you 
use a date. Add one or more Invoice Line.

Different GROUP MASTERs on the same trip.
It is possible to use different GROUP MASTERs 
on the same trip. For example. It can be a GROUP 
MASTER for an outward trip. Another GROUP 
MASTER for the return trip, and finally one or 
more GROUP MASTERs for the hotel, excursions, 
etc.

Booking GROUP MASTERs (OFFLINE):

To book from a GROUP MASTER, you must first 
create an order. It is created as usual, either from 
a PNR or manually. To book individual flights, this 
must be done before booking from a GROUP 
MASTER.

If you use a manual order, passenger names are 
inserted in the order before booking from the first 
GROUP MASTER, since there you cannot add or 
edit the name when it has been passed to a 
GROUP MASTER.

If there is an over subscription of  individual flight 
bookings, we recommend that these be invoiced 
before the booking from the first GROUP 
MASTER.

When all passengers are typed, booking of one or 
more GROUP MASTERS. Press button GRP in 
passenger tab:
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Then the following screen will appear:

From here you can add or remove GROUP 
MASTERs to or from that order. If the field > Create 
Invoice Lines < is selected, it will add the GROUP 
MASTERs Invoice Lines to that Order.

Invoice Lines are created in the latest open invoice. 
If there is no invoice, or there isn't an open invoice, 
it will create the new Invoice Lines in a new Invoice. 
This invoice will then be issued.

If you removed an order from a GROUP MASTER, 
it will not remove the invoice Lines. These must be 
done manually either by deleting the Invoice Lines 
if possible or else creating a Credit Note.

It is not possible to add the names to an order 
containing bookings from a GROUP MASTER.

However, this can be done by removing all GROUP 
MASTER bookings on that Order,

and then add the new name. Finally, repeat the 
booking from GROUP MASTERs.

Remember, in this case, to correct the invoices.

Booking from the GROUP MASTER (ONLINE):

To book from a GROUP MASTER online via the 
SoftSuitCase Web Service. See further description in 
the Web Service, in Customers and Orders:
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Overview of GROUP MASTERs

Choose Functions > Group View, or (CTRL + G) 
to obtain a list of available GROUP MASTERS.

It is possible to search for groups by typing part of 
the group name, the date of departure or 
destination, or any combination of these.

The list shows:
1: group name
2: departure date
3: Destination (IATA code)
4: GROUP MASTERS order number
5: The remaining number of vacant seats.

Press > OPEN < to open the GROUP MASTER.

Only the active GROUP MASTERs are displayed, 
where the Departure Date and the Offer Date has 
not expired.

Select the existing GROUP MASTER

May be an existing GROUP MASTER in the 
following way:

Group name and number of participants:

Open the GROUP MASTER.
Select Tools > Edit Group

Invoice Line
Open invoice. Delete, add or change the individual 
Invoice Lines.

Invoice field on each of the orders that have 
already used Invoice Lines from that GROUP 
MASTER are not corrected. Only future use of the 
Invoice Lines are affected by the correction.

Departure date, destination and Carrier.

It also affects only future bookings from the GROUP 
MASTER.

Segments
All changes in segments on the GROUP MASTER to 
change segments on all individual orders which have 
the booking from the GROUP MASTER.

For example, time changes, etc. must (and can only) 
be amended in that GROUP MASTER.

Vouchers from GROUP MASTERS

Cannot create Vouchers from the individual orders. 
Voucher must be created in the GROUP MASTER, 
and covers the persons that are booked in that 
GROUP MASTER

Fill in the Voucher required information as usual. 
When the Voucher is issued, the segment on the 
individual group bookings will show as a > V <
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What do you do when an error occurs?

There can be many reasons for an error. It may be 
a problem with your network or database, but it can 
also be a bug in SoftSuitCase.

If you get an error in SoftSuitCase you will be 
shown a window, where we appreciate if you give 
us a short explanation of what you were doing.

-What was I doing?
-What is the Order Number.?

The error will automatically be sent to the 
SoftSuitCase Help Desk and we might contact you 
for further information about the cause of the error.

If you cannot log on to SoftSuitCase, first of all 
check if you have the Internet access on that PC.

Why are there errors in SoftSuitCase?

There can be many reasons for an error in 
SoftSuitCase. One of the most common is that new 
users use the system in new ways, and perhaps do 
something that has never been done before.

We are constantly improving the system and 
therefore we are very interested in hearing from 
you, if you are experiencing errors and remember:

Even if your support period has expired, it costs 
nothing to contact us and get errors fixed.

Contact Help Desk

If you have a service agreement with TravelOffice, 
or if you are within the first 45 days of purchasing 
SoftSuitCase, we provide free support, it costs 
nothing to contact the Help Desk.

If you don't have support we will invoice you on a 
per call basis. Prices of calls can be checked on the 
TravelOffice's web site.

Remember it is always at least 25% cheaper to buy 
a Help Desk Coupon, which gives you access to 10 
calls to Help Desk.

The price of coupons also appears in the price list.

Support Calls on a 24-hour watch costs twice as 
much as regular calls.

How do you contact the SoftSuitCase Help Desk?

Our Help Desk is contacted via our Danish 
phone number:

+45 33 66 90 99
Our 24-hour on-call support can be contacted on + 
45 33 66 90 66 outside regular opening hours.

About languages in SoftSuitCase.

The individual Travel Agents are responsible for 
maintaining the written languages you use in 
SoftSuitCase. That is to say the languages you use 
when you send correspondence to your customers, 
either printed or by e-mail.

SoftSuitCase maintains (as best we can) the display 
languages, but there will always be some areas 
where the language is in English, which is our main 
programming language. If you find this to be a 
problem, let us know where the translation has to be 
done.

Responsibilities

We have tried to make this guide as correct as 
possible and it shows how SoftSuitCase worked at 
the time this manual was written.
 
We cannot be held responsible for changes or errors 
caused by the use of this user manual.

SOFTSUITCASE 2010 - USER MANUAL - VER. 7



50

ENTIRE AGREEMENT
Licensee acknowledges that Licensee has read this agreement 
and understands this agreement (the "Agreement") is the final, 
complete and exclusive statement of the entire agreement 
between TravelOffice ApS("TravelOffice") and Licensee.  This 
Agreement supersedes any prior and contemporaneous 
proposals, purchase orders, advertisements, and all other 
communications in relation to the subject matter of this 
agreement, whether oral or written.  No terms or conditions, 
other than those contained in this Agreement, and no other 
understanding or agreement which in any way modifies these 
terms and conditions, shall be binding upon TravelOffice unless 
made by a written agreement, executed by duly authorized 
representatives of both TravelOffice and Licensee.

LICENSED SOFTWARE AND DOCUMENTATION LICENSE
1.  TravelOffice hereby grants Licensee a non-exclusive, non-
transferrable and perpetual license to use the enclosed 
computer software (the "Licensed Software") and the associated 
printed documentation (the "Documentation"), subject to the 
limitations set forth in this Agreement (the "License").  
Licensee may use the Licensed Software only on one central 
processing unit with one input terminal.  All right, title and 
interest to the Licensed Software and the Documentation are, 
and shall remain, in TravelOffice or TravelOffice's licensors, as 
the case may be.  Licensee have no right of access to the 
source code of the Licensed Software.  Licensee is not entitled 
to updates or upgrades of the Licensed Software or 
Documentation.  

2.  Licensee may not alter, assign, create derivative works, 
decompile, disassemble, distribute, lease, modify, reverse 
engineer, sublicense, transfer or translate in any way the 
Licensed Software or Documentation (except as specifically and 
expressly provided below for "redistributable files"); provided, 
however, that Licensee may permanently and simultaneously 
transfer all of the Licensed Software, Documentation and the 
License if: a) Licensee delivers to the transferee the Licensed 
Software and Documentation; b) notify TravelOffice in writing of 
such transfer; and c) destroy any archival/backup copy.  
Licensee agrees that the transferee must expressly accept all 
terms and conditions of this Agreement. 

3.  Licensee MAY NOT COPY the Licensed Software or 
Documentation (except as specifically and expressly provided 
below for "redistributable files"); provided, however, that 
Licensee may make one (1) copy of the Licensed Software for 
archival/backup purposes.  

4.  Licensee may create application software using the Licensed 
Software, including the trade secrets and confidential 
information of TravelOffice, and Licensee may incorporate in 
such application software, in executable form, those files 
identified in the Documentation as "redistributable files."  
Licensee MAY NOT distribute the Licensed Software, in any 
format, to other users for development purposes. In particular, if 
Licensee creates a control using the Licensed Software as a 
constituent control, Licensee MAY NOT distribute the control 
created with the Licensed Software (in any format) to users for 
development purposes.

5.  If either the Licensed Software or Documentation is used in 
any way not expressly and specifically permitted by this License, 
then the License shall immediately terminate.  Upon the 
termination of the License, Licensee shall thereafter make no 
further use of the Licensed Software or Documentation, and 
Licensee shall return to TravelOffice all licensed materials, 
postage prepaid.  

WARRANTIES
1.  LIMITED WARRANTY ON DISTRIBUTION MEDIA.  For a 
period of thirty (30) days following the date of delivery of the 
Licensed Software and Documentation to Licensee as the 
original licensee, if evidenced by Licensee's receipt as such, (the 

"Warranty Period") TravelOffice warrants the DISTRIBUTION 
MEDIA (the "Media"), such as diskettes or CDs, on which the 
Licensed Software is embodied to be free from defects in 
materials and workmanship under normal use.  The warranty is 
personal to Licensee, and no warranty is made to Licensee's 
transferees.  Any implied warranties of merchantability or fitness 
for a particular purpose for the media are limited in duration to the 
Warranty Period, after which time all warranties, of whatever 
nature, are specifically disclaimed. 

2. NO WARRANTY ON LICENSED SOFTWARE OR 
DOCUMENTATION.  SUITCASE licenses the Licensed Software 
and Documentation solely on an "AS IS" basis without warranties 
of any kind, such as warranties of merchantability or fitness for 
any particular purpose.  The entire risk of quality and performance 
is with Licensee.  The Software and Documentation are not 
represented to be error-free.  If either the Licensed Software, 
Documentation or both prove to be defective, Licensee assumes 
the entire cost of all servicing, correction or repair. 

3.  The foregoing warranty gives Licensee specific legal rights, 
and Licensee may also have other rights which vary from state to 
state.  Some states do not allow the limitation or exclusion of 
implied warranties, so the above limitations may not apply to 
Licensee.

REMEDY FOR DEFECTIVE MEDIA
Licensee's sole and exclusive remedy in the event of a defect in a 
warranted item is expressly limited to replacement of the 
defective media.  To receive a replacement, Licensee must send 
the defective media, with proof of purchase, to TravelOffice at the 
address indicated below, postage pre-paid and postmarked within 
the Warranty Period.  In no event shall TravelOffice be liable for 
any other obligations or liabilities including, but not limited to, 
liability for damages (whether general or special, direct or indirect, 
consequential, incidental, exemplary), or for any claim for the loss 
of profits, business or information, or damage to good will even if 
TravelOffice has been advised of the possibility of such damages.  
In any event, TravelOffice's maximum liability shall be limited to 
the amount of the purchase price.  
Some states do not allow the limitation or exclusion of incidental 
or consequential damages, so the above limitations may not 
apply to Licensee.

The Licensed Software and ocumentation have been developed 
exclusively at private expense, and are provided with 
RESTRICTED RIGHTS.  Use, duplication or disclosure by the 
Government is subject to restrictions as set forth in subparagraph 
(c)(1)(ii) of the Rights in Technical Data and Computer 

TravelOffice is the Contractor, 
and is located at Nytorv 7, DK-1450 Copenhagen K, Denmark, 
Phone: +45 33 66 90 90

MISCELLANEOUS
This Agreement shall be considered severable, and if for any 
reason any term or condition is determined to be invalid, illegal or 
unenforceable under current or future law, such invalidity shall not 
impair the operation of, or otherwise effect, the valid terms and 
conditions of this Agreement, so long as the intent of this 
Agreement is maintained.

This Agreement shall be governed by, construed and enforced in 
accordance with the laws of the Commonwealth of Pennsylvania, 
with the exception of its conflict of law provisions.  The parties 
consent to the personal jurisdiction of the Commonwealth of 
Pennsylvania and agree that any legal proceedings arising out of 
this Agreement shall be conducted solely in such Commonwealth.

No action, regardless of form, arising out of this Agreement may 
be brought by either party more than one (1) year after a claim 
has accrued.

Copyright (C) 1991 - 2012 TravelOffice ApS.  
All rights reserved
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Operation systems Microsoft Windows NT©

Microsoft Windows2008©

Microsoft Windows 7©

Microsoft Vista©

GDS Amadeus, Sabre

& Worldspan

Minimum requiments Microsoft Vista/7© 2 GB RAM

Workstations NT512 GB RAM

50 GB Harddisk

Minimum requiments Microsoft Windows2003©

Server Microsoft Windows 2008©

2 GB RAM

50 GB Harddisk

In installations less than 6 users

server can be Microsoft Vista©

or Microsoft Windows 7©

FrontOffice Microsoft IIS

Online Booking Microsoft IIS

Platform Microsoft.NET© 4.0

Communication Internet required

Min. 2 Mbit download

Multi Locations Yes, please contact Soft

SuitCase for information

Max Users No maximum

Free support 45 days after installation

Free test Disabled

Contact:

www.traveloffice.dk

Headoffice:
Nytorv 7 - B
1450 Copenhagen K
Denmark

Tel.: +45 33 66 90 90
Email: info@traveloffice.dk

Technical support:
+45 33 66 90 99


